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Copyright © 2025 Telestream 2, LLC and its Affiliates. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, altered, or translated into any
languages without written permission of Telestream 2, LLC. Information and
specifications in this document are subject to change without notice and do not
represent a commitment on the part of Telestream. Specifications subject to change
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player,
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch,
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM,
Pipeline, Sentry, Surveyor, Vantage Cloud, CaptureVU, FlexVU, PRISM, Sentry, Stay
Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its Affiliates. All
other trademarks are the property of their respective owners.

Telestream products are covered by U.S. and foreign patents, issued and pending.
Information in this publication supersedes that in all previously published material.
Specifications and price change privileges reserved.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.
CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology
licensed from Fraunhofer IIS and Thomson Multimedia.

intoPIX and Fraunhofer. Notice under 35 U.S.C. §287(a): This product or service
includes JPEG XS compliant features that are covered by patents in the United States
and in other jurisdictions owned by intoPIX SA (“intoPIX”) and/or Fraunhofer-
Gesellschaft zur Foerderung der angewandten Forschung E.V. (“Fraunhofer”) and listed
at HYPERLINK http://www.jpegxspool.com. Additional patents may be pending in
United States and elsewhere.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

Built with Llama. Llama 3.1 and Llama 3.2 are licensed under the Llama Community
License, Copyright © Meta Platforms, Inc. All Rights Reserved. See https://
www.llama.com/llama3_1/license/ and https://www.llama.com/llama3_2/license/.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.



MCW. HEVC Decoding software licensed from MCW.
Medialnfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2019, Windows Server 2022, Windows Server
2025, Windows 11, Media Player, Media Encoder, .Net, Internet Explorer, SQL Server
2019, SQL Server 2022, and Windows Media Technologies are trademarks of Microsoft
Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs,
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Swagger. Licensed from SmartBear.

Telerik. RadControls for ASPNET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.
X264 LLC. The product is manufactured by Telestream under license from x264 LLC.
Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.
ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.
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Other brands, product names, and company names are trademarks of their respective
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent

ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE
FORTHE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO") AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE
HTTP://WWW.MPEGLA.COM.
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MPEGLA AVC

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FORTHE
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO") AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C.
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA
WHICH IS PAID FOR ON ATITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON
ATITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA,
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers

Telestream 2, LLC (the Company) warrants to the original registered end user that the
product will perform as stated below for a period of one (1) year from the date of
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment
supplied but not manufactured by the Company but NOT including any third party
equipment that has been substituted by the Distributor for such equipment (the
“Hardware"), will be free from defects in materials and workmanship under normal
operating conditions and use.

Warranty Remedies

Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any
defective Hardware component or part, or Software Media, with new or like new
Hardware components or Software Media. Components may not be necessarily the
same, but will be of equivalent operation and quality.

Software Updates

Except as may be provided in a separate agreement between Telestream and You, if
any, Telestream is under no obligation to maintain or support the Software and
Telestream has no obligation to furnish you with any further assistance, technical

PR
telestream



support, documentation, software, update, upgrades, or information of any nature or
kind.

Restrictions and Conditions of Limited Warranty

This Limited Warranty will be void and of no force and effect if (i) Product Hardware or
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration,
neglect, or shipping, or as a result of service or modification by a party other than the
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties

THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral
or written information or advice given by the Company, its distributors, dealers or
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any
Limited Warranty by the Company shall be the recovery of reasonable damages which,
in the aggregate, shall not exceed the total amount of the combined license fee and
purchase price paid by you for the Product.

Damages

TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC

848 Gold Flat Road

Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Server Regulatory Compliance

Electromagnetic Emissions: FCC Part 15 Subpart B, ICES-003, EN 55032, EN/BS 55024,
EN/BS EN 55035, EN 61000-3-2, BS EN 61000-3-2, EN 61000-3-3, BS EN 61000-3-3, VCCI-
CISPR 32, AS/NZS CISPR 32

Electromagnetic Immunity: EN 55035
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Safety: IEC 62368-1, EN 62368-1, CSA C22.2 No. 62368-1-14, UL 62368-1
Additional Country Certifications: NOM, IRAM S-Mark

California Best Management Practices Regulations for Perchlorate Materials:

This Perchlorate warning applies only to products containing CR (Manganese Dioxide)
Lithium coin cells. Perchlorate Material-special handling may apply. See
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Contact Telestream Customer Service for additional Regulatory Compliance certificates.

Contacting Telestream

Resource

Contact Information

Telestream Technical
Support Portal

Web Site: support.telestream.net

Vantage Technical
Support Portal

Web Site: telestream.net/telestream-support/vantage/
support.htm

Support Email: support@telestream.net

Terms and times of support services vary, per the terms of
your current service contract with Telestream.

Vantage Information,
Assistance, FAQs,
Forums, & Upgrades

Web Site: telestream.net/telestream-support/vantage/
support.htm

General Contact
Information

Web Site: telestream.net/company/contact-
telestream.htm

Telestream, LLC

Web Site: telestream.net
Sales and Marketing Email: info@telestream.net

International
Distributor Support

Web Site: telestream.net

See the Telestream site for your regional authorized
Telestream distributor.

Telestream Technical
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving
this document, or other Telestream documents—or if
you've discovered an error or omission, please email us.
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Planning and Managing a
Vantage Database

This guide lists Vantage database requirements and explains how to plan, install, and
maintain the database for a Vantage domain.

Installing a database in preparation for Vantage is easiest when you plan carefully, and
you have a working knowledge of Windows server administration, Microsoft SQL
Server, and installation and configuration of enterprise-level software. Consult your IT
group for assistance as necessary.

Note: Go to telestream.net/telestream-support/vantage/support.htm to browse the
Vantage web library, user guides, patches, application notes, and other documents.

Topics
m Operating System Requirements
m Database Server Requirements for SQL Standard
m Database Selection and Configuration
m Installing MS SQL Server
m Installing the Vantage Database
m Backing Up and Restoring the Vantage Database
m Shrinking a Full Database
m Moving the Vantage Domain Database to Another Database

o~
telestream


https://www.telestream.net/telestream-support/vantage/support.htm

10 ‘ Planning and Managing a Vantage Database
Operating System Requirements

Operating System Requirements

The Vantage domain database and the MS SQL Server for Vantage should be installed
and operated only on Windows Server 2019 | 2022 | 2025 Standard or Data Center
Edition.

Note: Operating system support presented here is current at the time of publication.
However, updates to supported operating systems may occur. Verify that the server on
which you plan to install Vantage meets the platform requirements, as specified at
telestream.net/vantage/tech-specs.htm.

Database Server Requirements for SQL Standard

The following recommendations are for customers running SQL Standard. To
determine which version of SQL to use, please refer to the Guidelines for Selecting SQL
Express or SQL Standard.

Telestream recommends using “per core” SQL Standard licensing when using Vantage.
In this licensing scenario, all physical cores on the server (or virtual machine) must be
licensed. Please contact your IT department or Microsoft for more information about
SQL Standard licensing options. For Microsoft’s discussion of licensing by cores, refer to
this URL: microsoft.com/licensing/guidance/Core-based-licensing-models.

Telestream recommends the following hardware for dedicated database servers:

Component Specification

CPU 64-bit, 4 physical cores, 8 MB cache, 3.0 GHz or greater. For
example, Intel E3-1230 v2.

RAM 32 GB DDR minimum, 64 GB or more recommended for high
job volumes; 1600 MHz recommended

OS/Software HDD RAID-1, 2 drive volume, minimum 7200 RPM, SSD preferred

Database HDD RAID-5, 3 drive volume, minimum 250 GB per drive, 7200 RPM

Network Dual 1 GbE or greater NICs

Please see the following page and table for additional guidelines.

When choosing your database server, the primary consideration is how many clients
will access job status views simultaneously. Real-time job status views are the largest
consumer of database CPU resources.

Use the information in this table to guide you in selecting a server and configuring the
system.
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Database Selection and Configuration

Job Status View Clients | Database Server Notes

1 or 2 clients 4-core server [IS and the Workflow Designer
may run on the database server.

3-8 clients 4-core server IIS and Workflow Designer must
run on a separate server.

More than 8 clients 8-core server (or more) | Contact Telestream for guidance
if you plan to deploy more than
20 clients.

Note: These recommendations ensure sufficient CPU headroom for activities such as
Workflow Portal operation, running large Vantage arrays, deleting jobs, etc.

For additional guidelines on database installation in a Vantage domain, see Database
Selection and Configuration.

Database Selection and Configuration

If no other Microsoft SQL database version is already installed, Vantage automatically
installs Microsoft SQL 2022 Express. If a Microsoft SQL database is already installed,
Vantage detects it and does not install the default Express version.

Vantage is supported on the following Microsoft database products:
 Microsoft SQL Server 2019 Express | Standard | Enterprise
 Microsoft SQL Server 2022 Express | Standard | Enterprise.
SQL Server should be installed and operated only on these operating systems:
» Windows Server 2019 Standard | Data Center Edition
» Windows Server 2022 Standard | Data Center Edition
» Windows Server 2025 Standard | Data Center Edition.
These topics provide guidelines for choosing and implementing your database:
m Guidelines for Selecting SQL Express or SQL Standard
m Guidelines for an Array Installation with SQL Standard
m Other Database Configurations
m Improving Uptime with Mirroring or Availability Groups
m [nstalling the Vantage Database

Note: SQL database tools must not be used to move a Vantage domain database of
one version to a later version of Vantage. To upgrade Vantage, only use Vantage
installers or the Vantage Database Deployment Utility.
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12 | Planning and Managing a Vantage Database
Database Selection and Configuration

Note: Depending on the security requirements of your organization's IT department,
the default credentials (sa/vantage12!) used by the SQL and Vantage database
installers may be insufficient. In such cases, Telestream recommends using the SQL
installer, which allows you to specify a custom user/password, then installing the
Vantage domain database with the Database Deployment Utility and providing your
custom user/password as specified.
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Planning and Managing a Vantage Database | 13
Database Selection and Configuration

Guidelines for Selecting SQL Express or SQL Standard

The decision about whether to use SQL Express or Standard depends on your planned
maximum database size and the expected average volume of database traffic. These
topics provide information to help you choose which database to use:

m Comparing SQL Express and SQL Standard
m Vantage Guidelines for SQL 2022 Express

Comparing SQL Express and SQL Standard
SQL Express and SQL Standard database limitations are compared in this table:

SQL 2019|2022 Express SQL 2019|2022 Standard

Max. Sockets / Cores: 1:4 Max. Sockets / Cores: 4:24|4:24|4:32
Max. DB RAM: 1.4 GB Max. DB RAM: 128|128|256 GB
2019|2022 Database Size: 10 GB | Max. Database Size: 524 PB

Microsoft offers additional information about SQL Server capabilities and limitations on
its web site.

Vantage ships with SQL 2022 Express, which is suitable for single-node installations or
arrays up to four nodes. For very large installations, SQL Standard may be required.

Vantage Guidelines for SQL 2022 Express

Vantage ships with SQL 2022 Express, which is suitable for single-node installations or
arrays up to four nodes. For very large installations, SQL Standard may be required.

These guidelines indicate the maximums for using Vantage with SQL 2022 Express:

» Transcoding: SQL 2022 Express supports up to 15,000 Vantage jobs in the data-
base at a time. This assumes that each job contains 10 actions. More actions in a job
require more storage, allowing fewer jobs.

» TrafficManager: SQL 2022 Express supports up to 1,500 TrafficManager commer-
cials in inventory at a time.

» Vantage Array: Up to four Vantage servers can simultaneously connect to SQL
2022 Express as part of an array. This includes any redundant or backup machines.

Database Shutoff Feature for SQL Express

If a Vantage single-node or array installation using SQL Express nears the SQL Express
database size limit, Vantage stops accepting jobs. Attempts to submit jobs manually
launches a warning dialog indicating that the database is at or near capacity. To release
space in the database, see the procedure in the Managing a Vantage Domain chapter:
Shrinking a Full Database in the Vantage Domain Management Guide.
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14 | Planning and Managing a Vantage Database
Database Selection and Configuration

Guidelines for an Array Installation with SQL Standard

For high traffic installations, Vantage performance improves when you use SQL
Standard and separate the database from Vantage services. These guidelines provide
increasing levels of performance improvement:

» Always place SQL Standard and the database on a dedicated server, separate from
Vantage services, the Vantage store, and the input and output files. This approach
provides the largest increase in performance.

» Place the Vantage database files on a dedicated physical drive or RAID array, sepa-
rate from the operating system.

Note: Installing a Vantage domain database on a separate server does not require an
extra Vantage license for that server.

When installing a Vantage array with SQL Standard, ensure that the server hardware
meets the requirements described in Operating System Requirements. To improve
database availability, see Improving Uptime with Mirroring or Availability Groups.

Recommendations for Large Arrays
For arrays containing 10 or more nodes, consider these additional recommendations: .

Feature Recommendation

Server memory for DB < 32 GB | 64 GB

Server memory for DB>32GB | 128 GB

Cores 16 cores minimum, 24 cores recommended.
Partitioning Create a dedicated partition for SQL Server data.
SSD or hard drives SSDs may provide better performance but only in

cases of high 1/0. Use SQL to monitor I/0 wait times
and PERFMON to measure average disk I/0 latency.
Latency should be less than 0.020 seconds (20 ms).

Other Database Configurations
Vantage systems can work with other special database configurations:

 For a fully redundant system, you can use SQL Server Standard with Mirroring. This
requires professional services from Telestream with machines and licenses for two
SQL Server Standard databases, plus a third machine running the free SQL Server
Express.

 Large volume systems can use SQL Enterprise.

» You can use SQL with Clustering.
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Installing MS SQL Server

Improving Uptime with Mirroring or Availability Groups
SQL Server Availability Groups or database mirroring can prevent Vantage domain
interruption if a single database server fails.

Telestream supports Basic Availability Groups for SQL Server 2019 Standard | SQL
Server 2022 Standard. Database mirroring is also supported.

SQL Enterprise with Clustering may also be used for high availability.
A mirrored database requires the following physical servers:
» Adedicated server to host the principal database

» Adedicated server (of similar capability to the principal database server) to host the
mirror database

» An optional dedicated server to host the witness server.

The witness database is a lightweight service which can run effectively on a low-end
server, but cannot be installed on a database server.

Basic Availability Groups require:
» Adedicated server to host the primary replica database
» Adedicated server (of similar capacity) to host the secondary replica database

¢ A reliable witness file share server.

Note: This guide does not provide instructions for installing or implementing a
mirrored database or Availability Groups. Consult your database administrator or
contact your Telestream representative regarding installation service options.

Note: Telestream strongly recommends using a dedicated server for the witness
server to ensure uninterrupted operation in case of a database failover. If the witness
server function is placed on a server with Vantage services, transcoding can consume
too many resources and prevent timely database switchover.

Note: If a mirrored database fails over, the domain change is not reflected in Vantage
client program title bars, which still show the original domain name. Users can correct
this by using File > Change Vantage Domain in the clients to select the new domain.

Installing MS SQL Server

If you are creating or upgrading a Single-Node Vantage installation, pre-installing the
database is not necessary. The Vantage Setup installer will install MS SQL Server Express
and the Vantage database automatically on the single-node server with the Vantage
applications and services.

However, if you are installing or upgrading an existing Vantage array on multiple
servers, you need to have MS SQL Server Standard (or better) installed before you install
the Vantage product using the Vantage Setup installer. This procedure will guide you

VT
telestream



16 | Planning and Managing a Vantage Database
Installing MS SQL Server

through the MS SQL Server Standard installation, and the procedure that follows
(Installing the Vantage Database) will install or upgrade the Vantage database. After SQL
Server and the Vantage database are installed, you can install the Vantage array using
the Vantage Setup installer.

This guide does not provide instructions for installing a mirrored database and
implementing mirroring. Consult your database administrator or contact your
Telestream representative regarding installation service options.To set up the Vantage
domain database, follow these procedures in the order listed:

m Installing SQL Server 2019 | 2022 Standard

m Installing the Vantage Database

Installing SQL Server 2019 | 2022 Standard

Follow these steps to install SQL Server 2019 Standard | SQL Server 2022 Standard (skip
this topic if you have already installed any of these versions):

1. Launch setup from the SQL Server 2019 | 2022 Standard installation media.
2. In the SQL Server Installation Center, select Installation on the left.

3. Select New SQL Server Stand-alone installation or add features to an existing
installation.

4, On the Product Key page (For SQL Server 2022, this is called the Edition page), enter
the product key and click Next.

5. Accept the license terms and click Next.
6. Click Next on the Microsoft Update page and the Install Rules page.

7. On the Feature Selection page, click Feature Selection on the left, enable Database
Engine Services and click Next.

8. On the Instance Configuration page, select Named instance, enter VANTAGE and
click Next.

9. Click the cell where the SQL Server Database Engine Row and Account Name
column intersect. After selecting the cell, click the drop-down list and select
<<Browse...>>.

10. In the Enter the object name to select field, type NETWORK SERVICE and click OK.
Then click Next on the Server Configuration page.

11. On the Database Engine Configuration page, select Mixed Mode (SQL Server
authentication and Windows authentication). Enter vantage12!for the password and
click the Add Current User button.

12. (Optional) If you would like to specify a non-default location for the database files,
go to the Database Engine Configuration page, select the Data Directories tab, and
change the Data root directory path.

13. Click Next on the Database Engine Configuration page.
14. Click Install on the Ready to Install page.

15. When installation completes, click Close and close the SQL Server Installation
window.
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Planning and Managing a Vantage Database | 17
Installing the Vantage Database

Installing SQL Server Management Studio

Management Studio is not automatically installed for SQL Server 2019 | 2022. To install
and configure it, follow these steps:

1. Browse to msdn.microsoft.com/en-us/library/mt238290.aspx.

2. Click the link to “Download SQL Server Management Studio.” Supported versions
are 19.2 or later.

3. After the download completes, launch the setup and click Install.
4, Click Close when the installation completes.

After the SQL Server Management Studio has been installed, it must be used to set the
maximum limit for SQL Server's memory consumption:

1. From the Start menu, launch the SQL Server Management Studio.
2, Connect to the instance using SQL Server Authentication:

Server name: \VANTAGE

Authentication: SQL Server Authentication

Login: sa

Password: vantage12!

3. Right-click the hostname at the top of the Object Explorer tree and select
Properties.

4, From the Select a page panel, go to Memory and set Maximum server memory (in
MB) to 75% of the host system’s memory. For example, if the system's memory is 8
GB (8192 MB), then the maximum server memory for SQL should be set to 6 GB
(6144 MB) (8192 x 0.75 = 6144).

5. Click OK to close the Microsoft SQL Server Management Studio window.

Now that SQL Server Standard is installed and configured for Vantage, install the
Vantage domain database as explained in this topic: Installing the Vantage Domain
Database. The Vantage installer will detect that SQL Standard is already installed, will
not install SQL Express, and will attach to the installed instance.

Installing the Vantage Database

If you have already installed MS SQL Server, the Vantage Installer allows you to install or
upgrade your existing Vantage database in the existing SQL installation. You can install
in any of these MS SQL database versions:

e SQL Express

« SQL Standard | SQL Standard with Mirroring | SQL Standard with Clustering. Cluster-
ing requires SQL Enterprise. For SQL Standard, Telestream supports SQL Basic Avail-
ability Groups.

 SQL Enterprise | SQL Enterprise with Clustering

Before you begin, perform the prerequisite procedure following.
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Installing the Vantage Database

Prerequisites for SQL Instance Installation

It is assumed you have already created a SQL database instance into which a Vantage
database instance can be deployed. The instance must meet these prerequisites before
you can use the Vantage utility to deploy a Vantage database instance:

» The SQL instance must be deployed as a named instance.

» The SQL instance mustinclude a SQL or active directory user account. The user can
be sa or another account, and any password may be used.

The user account installing the Vantage database must have the sysadmin role
assigned. The steps below explain how to assign a role.

e The user account running the Vantage database can use db_owner and dbcreator
roles instead of sysadmin, if you prefer the user to have lower privileges.

Configuring the Administrator Role

1. In the SQL Server Management Studio > Object Explorer panel, expand Security,
and expand Logins.

2. Right-click the sa user or another user that you want to use as the administrator
login, and select Properties.

3. Goto Server Roles and enable public and sysadmin. Click OK. This gives the user
system administrator privileges for the database instance.

[ Login Properties - TELESTREAM\chuckp =Ny X
Selecta page ‘ = v I
1 General ; Serpt U Help
S ok
44 |ser Mapping Server role is used to grant server-wide security privileges to a user.
# Securables
1 Status
Server roles:
[T bulkadmin
- [] dbereator
Coan [] diskadmin
Server: [7] processadmin
W-CHUCKPA\DBUTILTEST [¥] public
Connection: 7] securtyadmin
ez ’ [] serveradmin
[] setupadmin
3 View connection properties [¥] sysadmin
Progress
Ready
oK | [ Cancel

Configuring the Vantage User Role

1. Right-click the current Windows user and select Properties.
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2. Click User Mapping. Check master or Vantage (if present) in the database column,
and check db_owner. Click OK.

Server:
W-CHUCKPA\DBUTILTEST

Connection:
TELESTREAM'chuckp

Qj View connection properties

Progress
Ready

5 Login Properties - TELESTREAM\chuckp [E=NEER™
i;;z‘::;:ﬂe 5 Sarpt = [ Help
|27 Server Roles
ﬁ‘ User Mapping Users mapped to this login:
ﬁ‘ Securables Map Database User Default Schema
2 Status —— TELESTREAM'chuckp ]
[ model
[ msdb
[ tempdb
Vartage
o Database role membership for: master
i

[] db_accessadmin

["] db_backupoperator

["] db_datareader

[] db_datawriter

[] db_ddladmin

["] db_denydatareader

[] db_denydatawriter

ld_omner
[] db_securityadmin

[¥] public

] [ Cancel

3. Right-click the Windows user and select Properties again.

4, Click Server Roles and check dbcreator to enable it. Click OK. This provides the
current Windows user sufficient privileges to run the Vantage database instance.

-
ﬁ Login Properties - NT AUTHORITYASYSTEM

mﬁlg

Selecta page
4 General

ﬁ‘ Server Roles
1# User Mapping
# Securables
1 Status

Connection

Server:
W-CHUCKPA\DBUTILTEST

Connection:
TELESTREAM'chuckp

Qj View connection properties

Progress
Ready

55 Seipt = [ Help

Server role is used to grant server-wide security privileges to a user.

Server roles:

[7] bulkadmin

Edemmtor
[] diskadmin

[ processadmin

[¥] public

[T securityadmin

[] serveradmin

[] setupadmin

[ sysadmin

[ ok ][ Ccancel

5. From the Select a page panel, go to Memory and set Maximum server memory (in
MB) to 75% of the host system’s memory. For example, if the system memory is 8 GB
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(8192 MB), then the maximum server memory for SQL should be set to 6 GB (6144
MB) (8192 x 0.75 = 6144).

6. Click OK to close the Microsoft SQL Server Management Studio window.

Installing the Vantage Domain Database

Perform these steps to install a clean new Vantage domain database instance into the
previously-installed SQL database:

1. Log into the database server with a local administrator account, and make sure that
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or
systems, you must turn off Windows Firewall.

2, Stop the SQL Server Agent Service in Start > Services, if it is running.

3. Run the Vantage _8.3.##_Setup.exe installer. See Vantage Installers Overview for
details.

4. When the Welcome dialog displays, click Next to display the license agreement.

5. License Agreement—Click | Accept if you agree to the license terms, and then click
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select the type of installation you want to perform: Install Product or Custom
Install. Install Product lists products and options in licensed groups. Custom Install
lists every Vantage component and option and allows you to select what you want.
Click Next.

8. Browse to Configure the installation locations for the Installation base, the default
Vantage store. Defaults are recommended.

9. Enable Install Vantage Database to install the Vantage database.

10. Optionally, to specify a different location for the database files than the default
location, change the Database store directory path.

11. When Ready to Install displays, click Install to begin installation, which takes a few
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL
Server 2022 Express is installed. Similarly, if no Vantage database is found, a new one is
installed. If a Vantage database is found, it is upgraded; upgrading preserves
workflows, design items, job history, catalogs, stores, application configurations, user
settings and licenses.

12. Click Next when the installer indicates it is finished.

13. The installer displays Installation was successful! (or indicates errors if unsuccessful).
Click Done to close the installer application. Database installation is complete.
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Launch the SQL Server Management Studio.

Connect to the instance using SQL Server Authentication:

Server name: \VANTAGE

Authentication: SQL Server Authentication

Login: sa

Password: vantage12!

Right-click the hostname at the top of the Object Explorer tree and select
Properties.

Go to Memory on the left and set “Maximum server memory (in MB)”to 75% of the
server's memory. Click OK.

You are now ready to install or upgrade Vantage:

a. New Vantage Installations: If you are installing a new Vantage instance, run the
Vantage_8.3 installer again, select Array {Multi-Node} Installation, select Custom,
select the components you want, but do NOT select Database. This ensures
Vantage installs, but the database is not touched.

b. Upgrading Vantage: If you are upgrading an existing Vantage instance, use the
Control Panel Programs and Features to remove only Vantage but leave MS SQL
and the domain database in place. Then run the Vantage_8.3 installer, select
Array {Multi-Node} Installation, select Custom, select the components you want,
but do NOT select Database. This ensures Vantage installs, but the upgraded
database is not touched.
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19. After Vantage installation, use the Vantage Management Console > File > Change

Select Vantage Domain

Select a Vantage Domain:

Specify Vantage Domain name/IP address [ . 153-4

Vantage Domain (shown below) to find and connect your Vantage installation to
the deployed database. Use the Search button to populate the list.

If you installed a Vantage database with a custom name and password, you may
need to select Specify Vantage Domain name/IP Address. Then enter the server
name, the custom database name, expand the Connection settings, and enter the
custom Login and Password. When you click OK, the Vantage Management Console
should connect to the database and begin normal operation.

Select Vantage Domain

Select a Vantage Domain:
3RDPARTY
HE-04
HE-10
K20-RED
L52-2012-08147

* Connection Settings LS2-ADAM

L53-11

53-A001-0415
PROTO-1
LS3-PROTO-2
TESTSYSTEM
W-DOMI2
W-MICHELLE!
W-TECHPUBSTEST

* Connection Settings

Specify Vantage Domain name/IP address I | Cancel

REMINDER: If you use Windows authentication, you must also set the SQL Server
service Log On to the same Windows account that you use for database authentica-
tion. To change the SQL Server service Log On, select Start > Administrative Tools >
Services > SQL Server > Properties > Log On > This account.

20. If necessary (for a new installation), install Vantage licenses using the Vantage

Management Console > Licenses panel and configure Vantage as described in the
Vantage Domain Management Guide.

21. If you have deployed a new database or replaced an existing database with a new

one, the domain will not have any ComponentPacs installed. When you run the
Vantage Setup installer to install Vantage components and services after deploying
the database, the major ComponentPacs will be installed. If you do not run the
Vantage Setup installer after database deployment on the database server, or if you
wish to install additional ComponentPacs, use the Vantage Management Console >
ComponentPac Management feature to install the ComponentPacs.

22, Lastly, if you assigned the Vantage services to the host name of the database server
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before using the Database Deployment Utility, use the Microsoft Services Console
to restart the Vantage services after the database is deployed. Also close and
reopen the Vantage Management Console and Workflow Designer. These
operations prevent a situation where Vantage action templates and fulfillment
schemes do not deploy properly.
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Backing Up and Restoring the Vantage Database

The Domain Backup feature allows you to save archival copies of the Vantage domain
database in a separate file. The Domain Restore feature allows you to replace your
current Vantage domain database with the contents of a previously-backed up domain.
The domain backup and restore features are primarily used for the following:

» Returning the database to a previously backed-up state.

» Preparation for database mirroring.

Note: The domain backup and restore features are not designed for use during
Vantage upgrades. If you back up the database from a specific version of Vantage, that
backup can only be restored to the same Vantage software version. During a Vantage
upgrade, the Vantage installers manage any required database updates as described
in Upgrading from a Previous Version in the Vantage Installation Guide or the Vantage
Domain Management Guide.

The following topics describe domain backup and restore:
m Understanding Domain Backup and Restore
m Backing Up the Domain
m Restoring the Domain

Understanding Domain Backup and Restore

During a domain backup, Vantage creates a single backup file that contains all
workflows, all services, and all jobs registered in the domain. It is important to
remember that the backup file contents reflect the domain contents as of the moment
the backup file is created. To capture changes made after a backup, you must create
another backup.

When you restore a domain, all services are stopped, the current database contents are
irretrievably destroyed, and the backup file you specify is used to create the
replacement database. The services defined in the backup file are started and the
Vantage domain database repopulates with the backup database values.

Because the restore feature irretrievably destroys the contents of the current database,
Telestream recommends that you back up the current database before restoring a
previous database. Backing up the current database captures all database changes
made since the last backup, and it gives you a backup file that you can use to restore
the current database if necessary.
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Backing Up the Domain

To back up the Vantage domain database, do this:

1. Start the Vantage Management Console as described in Starting the Vantage
Management Console in the Vantage System Administration Guide or the Vantage

Domain Management Guide.

2. In the components panel, select Domain Management.

Vantage displays the Domain Management details panel shown here:

-
f§ Vantage Management Console [W-CHUCKP]

FEile Options

B Settings & Options Domain Management
i Catalogs
@ Storage

¥ Licenses
Status

o5 Workflow Design Items

1" Domain Workflow Analytics
8 Support Utilities

& Application Configurations
8 Report Configurations + Agility

Active Services:
Service
«" Transport
+" VidChecker

+" Aurora

f Fulfillment Schemes +" Staging

£ Users " Traffic
(77 Bomain Management T
" Metric

#" Aspera
«" Metadata
+" Multiscreen
+" Nexidia
o Anaiysis

B .
#" Communicate

Backup Domain: Backup...

o Cepicn Restore Domain: Restore...

Shrink Database: Shrink  Current Size: 149 MB

W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP
W-CHUCKP

Machine

Online
Maintenance
Maintenance
Online
Online
Online
Online
Online
Online
Online
Online
Maintenance
Online

Online

24 items

3. Verify that all services in the Active Services list are hosting 0 sessions.

Note: Although you can create a successful backup while services are executing
workflow tasks, some job records may be lost. It is best to back up the domain when

there is no activity in the domain.

4, Click the Backup... button.

5. In the Save the domain dialog, browse to the folder where you want to store the

backup file, and click Save.

6. When the Backup Complete message displays, click OK.
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Restoring the Domain

CAUTION: Telestream recommends that you restore a Vantage domain using the
same machine that created the backup file. If you restore the domain from another
machine, the services defined in the database must match the services installed on
the other machine.

To restore a Vantage domain database, do this:

1. Start the Vantage Management Console as described in Starting the Vantage
Management Console in the Vantage System Administration Guide or the Vantage
Domain Management Guide.

2. In the components panel, select Domain Management.
Vantage displays the Domain Management panel shown in the previous figure.

3. To provide the option to return to the current Vantage domain database later, back
up the current domain database as described in Backing Up the Domain.

CAUTION: Always back up your current database before restoring it to an earlier
backup. Restoring your Vantage domain database overwrites the entire contents of
the current database with the contents of the backup file selected.

4, Verify that all services in the Active Services list are hosting 0 sessions.

Note: When you restore a domain, all services are stopped, and all information
related to any jobs in progress is lost. The restored database contains only the domain
information captured when the domain was backed up.

5. Click the Restore... button, read the information dialog that displays, and click OK.

6. In the Load the domain dialog, browse to the backup file you want to restore, select
the backup file, and click Open.

7. When the Restore Complete message displays, click OK.

Shrinking a Full Database

If a Vantage installation using SQL Express nears the SQL Express database size limit,
Vantage stops accepting jobs. Attempts to submit jobs manually launches a warning
dialog indicating that the database is at or near capacity.

You may be able to resolve this issue using the Vantage Shrink Database feature, which
applies the MS SQL DBCC SHRINKDATABASE command to the existing database to
delete unused entries and reduce file size. The shrink process may take some time and
may slow database performance, so it should be done only when the Vantage system is
not busy.

Use this procedure to shrink the database:

1. Start the Vantage Management Console.
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2.

In the components panel, select Domain Management.
Vantage displays the Domain Management details panel (see the preceding figure).

. To protect against potential data loss, use the Backup... button to back up the

current domain database as described in Backing Up the Domain.

. Click the Shrink button to shrink the database.

A dialog pops up to explain that the Shrink command may affect database perfor-
mance and should be done only when Vantage is not busy.

A Status message indicates progress.

Current Size displays the database size next to the button, so you can see any
changes immediately upon completion of the shrink command.

Multiple presses of the button may shrink the database additionally each time.

Moving the Vantage Domain Database to Another

Database

You might want to move the Vantage domain database because:

You are upgrading SQL Server from Express to Standard
You are upgrading SQL Server from an older version to a newer one

You are moving the database from one server to another

Note: This procedure backs up the database, moves the database to a different SQL
Server version and/or server, and restores the database. Vantage does not support a
Vantage restore from one Vantage database version to another. If you are upgrading
Vantage and moving the database, upgrade Vantage first, and then move the
database.

Note: This guide does not provide instructions for moving a mirrored database.
Consult your database administrator or contact your Telestream representative
regarding installation service options.

To move a Vantage domain database, follow the procedures in the following topics in
the sequence presented:

1.
. Backing up the Existing Database

0 N O L1 A W N
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Preparing for the Move

. Removing the Vantage Domain Database

. Removing Microsoft SQL Server

. Installing SQL Server Standard

. Installing the Vantage Domain Database

. Restoring the Vantage Domain Database Backup
. Finishing the Move
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Preparing for the Move

If you are upgrading SQL Server, it is recommended but not required that you back up
the Vantage domain database. However, if you are moving the Vantage domain
database to a new server, you must backup the database, as the backup file will be used
to restore the domain on the new server.

To back up the existing Vantage domain database so that it can be transferred to the
new database later, follow these steps:

1. Use Vantage Workflow Designer to deactivate all active workflows to prevent new
jobs from starting.

2. Use the Job Status Views tab in Vantage Workflow Designer, the Vantage Job Status
Views web application, or Vantage Dashboard to either determine when all jobs are
complete or stop any jobs in process or in waiting.

3. If you are moving the database to another server, do this:

a. Take note of any Storage, Variables, and/or Qualification Rules settings for each
service. (In the Vantage Management Console, select Services. In the service
panel, click each service and check the tabs at the bottom of the window.)

When you move the Vantage domain database from one server to another, the
Storage, Variable, and Quialification rule configuration for each service is lost.
Write down any configuration that you want to transfer to the new server.

Note: The service Storage, Variable, and Qualification Rule configuration is not lost
when you change the SQL Server version on a server. Skip to Step 4 if you are not
moving the Vantage domain database to a different server.

b. In the Vantage Management Console, remove all services from the Vantage
domain as described in Removing a Service from the Domain in the Vantage
Domain Management Guide.

Note: The default Vantage user account is Administrator with no password. This
account has administrative privileges.

¢c. In the Vantage Management Console, select Licenses in the components panel.
d.On the Licenses tab, select all licenses and click the Delete button x.

Note: To add the licenses back a the end of this procedure, you will need access to the
license files. If you do not know where these files are, locate them now before you
delete them from the existing database.

4. If you are changing the Microsoft SQL version on a server (and not moving the
database to another server), place all services in Maintenance Mode as described in
Entering and Exiting Service Maintenance Mode.
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Backing up the Existing Database

If you're upgrading SQL Server, Telestream recommends that you back up the Vantage
database. If you're moving the Vantage domain database to a new server, you must
back up the database, as the backup file will be used to restore the domain on the new
server.

To back up the existing Vantage domain database so that it can be transferred to the
new database later, follow these steps:

1. In the Vantage Management Console, select the domain you want to modify, select
Domain Management in the components panel, click Backup..., and use the file
save dialog to save the backup file to a safe location.

You will need to access the backup file to restore the Vantage domain database
after you move it. For more information, see Backing Up the Domain.

2. Close all Vantage clients—Vantage Workflow Designer, Vantage web applications,
Vantage Workflow Portal, Dublist Portal, and Vantage Management Console.

Removing the Vantage Domain Database

The Vantage domain database may or may not be present as a separate entry in the
Windows Control Panel Programs and Features window, depending on how it was
originally installed.

In either case, the Domain Database must be removed using one of the following
procedures:

If the Domain Database is present in the Control Panel list, remove it as follows:
1. Log into the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage Domain Database and click Remove or Uninstall.
If the Domain Database is not present in the Control Panel list, remove it as follows:
1. Log into the server with a local administrator account.
2. Open the control panel tool to remove programs in your operating system:
Control Panel > Programs and Features > Uninstall Programs.
3. Select Vantage and click Change.
4. Deselect the check box for Vantage Domain Database and continue with removal.
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Removing Microsoft SQL Server

When you are upgrading Microsoft SQL Server or moving the Vantage domain
database to another server, you may want to remove the old version of SQL Server.

To remove Microsoft SQL Server, follow these steps:
1. Log into the server with a local administrator account.

2. Open the control panel tool for removing programs:
Control Panel > Programs and Features > Uninstall Programs.

3. Select Microsoft SQL Server and click Remove or Uninstall.

Note: If you are prompted to stop the SQL Server (VANTAGE) service, go to Start >
Services and stop the service before clicking Retry to continue with uninstalling.

Note: If you have multiple instances (for example SQLEXPRESS and VANTAGE), you
will need to remove them both.

4, Select Microsoft SQL Server Native Client and click Remove or Uninstall.

Note: Uninstalling the SQL Server does not delete your Vantage workflows, resources,
or transaction history. It leaves your domain database files intact in
[Install_Drive]:\Program Files\Telestream\Vantage\Database. For information on
removing the database files, see Uninstalling Vantage from a Server in the Vantage
Installation Guide or the Vantage Domain Management Guide.

At this point, the SQL Server is removed but the database files and any Vantage services
and clients that were installed on the server remain installed. The domain cannot
resume operation until the SQL Server is reinstalled on this server or set up on another
server.

VT
telestream



30 | Planning and Managing a Vantage Database
Moving the Vantage Domain Database to Another Database

Installing SQL Server Standard

Please see Installing SQL Server 2019 | 2022 Standard earlier in this chapter. After
installing SQL, continue with the next topic to install the Vantage database.

Installing the Vantage Domain Database

This task installs the Vantage domain database instance. Follow these steps:

1. Log into the database server with a local administrator account, and make sure that
virus-checking software and Windows Firewall is off.

Note: To effectively operate Vantage services with other networked devices or
systems, you must turn off Windows Firewall.

2. Stop the SQL Server Agent Service in Start > Services, if it is running.

3. Run the Vantage _8.3.##_Setup.exe installer. See Vantage Installers Overview for
details.

4. When the Welcome dialog displays, click Next to display the license agreement.

5. License Agreement—Click | Accept if you agree to the license terms, and then click
Next.

6. Select Array {Multi-Node} Installation and click Next.

7. Select the type of installation you want to perform: Install Product or Custom
Install. Install Product lists products and options in licensed groups. Custom Install
lists every Vantage component and option and allows you to select what you want.
Click Next.

8. Browse to Configure the installation locations for the Installation base, the default
Vantage store. Defaults are recommended.

9. Enable Install Vantage Database to install the Vantage database.

10. When Ready to Install displays, click Install to begin installation, which takes a few
minutes. Progress is displayed as the installation takes place.

Note: The Vantage Setup program checks for an existing SQL Server installation, and
if found, Setup skips the installation of SQL Server. If SQL Server is not found, SQL
Server 2022 Express will be installed. Similarly, if no Vantage database is found, a new
one is installed. If a Vantage database is found, it is upgraded; upgrading preserves
workflows, design items, job history, catalogs, stores, application configurations, user
settings, and licenses.

11. Click Next when the installer indicates it is finished.

12. The installer displays Installation was successful! (or indicates errors if unsuccessful).
Click Done to close the installer application. Database installation is complete.

If you are upgrading SQL Server on the same server, the upgrade is almost complete.
Vantage should have discovered the old database files. Now you need to finish the
process as described in Finishing the Move.
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If the old database files are not found, or if you are installing the Vantage domain
database on a different server, restore the database from the backup file as described in
Restoring the Vantage Domain Database Backup.

Restoring the Vantage Domain Database Backup

To restore the Vantage domain database using the backup file you previously created,
follow these steps:

1. Start the Vantage Management Console on any Vantage server in the domain.

Note: If you have moved the Vantage domain database to a new server, the name of
the Vantage domain changed to the name of the new host server.

2. In the Vantage Management Console, select the domain to modify, select Domain
Management in the components panel, click Restore..., and select the file to restore.
For more information, see Backing Up the Domain in the Vantage System
Administration Guide or the Vantage Domain Management Guide.

Finishing the Move

To finish the move, you must enable the services you disabled when preparing for the
move. If you moved the Vantage domain database to another server, you must also
install Vantage licenses. To return Vantage to operation, follow these steps:

1. If you changed the Microsoft SQL version on a server (and did not move the
database to another server), do this:
a. Remove all services from Maintenance Mode as described in Entering and Exiting

Service Maintenance Mode in the Vantage System Administration Guide or the
Vantage Domain Management Guide.

b. Skip to Step 4.

2. If you moved the Vantage domain database to a different server, activate Vantage
Domain licenses as follows:

a. In the Vantage Management Console, open the domain you want to modify, and
select Licenses in the components panel.

b. On the Licenses tab, click the Add License button # and use the open file dialog
to select the license file.
If your domain has multiple license files (for multiple features), repeat this step
for additional licenses.
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3. If you moved the database to another server, update the configuration of services

as follows:

a. In the Vantage Management Console, open the domain you want to modify, and
select Services in the components panel.

b. In the Services panel, click the Add Service button # and use the dialog to select
a service to add.

c. If any Storage, Variables, and/or Qualification Rules settings were configured for
the service, add them now.

d. Repeat this step for each service until all services are updated.

4. Use Vantage Workflow Designer to reactivate all workflows.
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